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ASSIGNMENT; 1

ANS: A computer has four mam c
processing unit or CPU, the primary
bus conn

among them. This type of
itecture is called a "von
ohn von Neumann, who finalized the
modern digital computer.

ts typically call the CPU the "brain™ of the
computer because this is where programs are executed. A
program is a set of instructions that tells the computer how to
accomplish a specific task, such as sending a file to the printer,
opening a browser window, or playing music or video.




The CPU is further broken up into three smaller components: the
arithmetic unit handles all the simple mathematical computations; the
control units interpret the instructions in a computer program; and the
instruction decoding unit converts computer programming
instructions into machine code. Machine code is the basic language
understood by all the components in a computer.

Memory

Once the CPU converts a specific am ifistructions
into machine code, it stores that m fy storage or
memory. The machine code will be treat [ a or instructions.
The CPU fetches data and instructions from Yy, Uses an instruction

to manipulate the dat hen se'he resdlt’and the next set of
instructions bac

devices, in ing data from the "outside world" into your
computer, in much the same way that your eyes and ears bring
information to your brain. Each input device has its own hardware
controller that connects to the CPU and primary memory, and it has a set
of instructions that tells the CPU how to use it.




Output Units

Output units are the devices your computer uses to relay information to
the user, such as a printer, monitors and speakers. For example,
everything you see on your computer monitor starts as machine code in
memory. The CPU takes that machine code and converts it into a format
required by your monitor's hardware. Your moni

converts that information into different light intensiti that you see
words or pictures

COMPUTER BLOCK




Q2: discuss about the classification of computer based on
size and capacity?

Ans-Based on size and capability, computers are broadly classified into

Microcomputers(Personal Co

Microcomputer can be classified into 2
Desktops

Portables
hile travelling whereas

smaller. Th xpensive than desktop. The weight of laptop is
around 3 to 5 Kkg.

Notebook: - These computers are as powerful as desktop but size of
these computers are comparatively smaller than laptop and desktop.
They weigh 2 to 3 kg. They are more costly than laptop.




Palmtop (Hand held): - They are also called as personal Digital
Assistant (PDA). These computers are small in size. They can be held in
hands. It is capable of doing word processing, spreadsheets and hand
writing recognition, game playing, faxing and paging. These computers
are not as powerful as desktop computers. Ex: - 3com palmV.

Wearable computer: - The size of this computer is very small so that it
can be worn on the body. It has smaller processing power. It is used in
the field of medicine. For example pace maker to correct the heart beats.
Insulin meter to find the levels of insulin in the blood.

C) ith la storage
capacities and very high speed mini- or
microcomputers) are known as They support a
large number of terminals for si umber of users
like ATM transactions. They are also use

distributed data procegsi

measured in terms of tens of
million d (mips), an operation is made up of
nume [ : computer is mainly used for large scale
numefi€al problemgpi jentific and engineering disciplines such as
Weath@ganalysis.
Examples: - IBM Deep Blue

et




Q3: what is the meaning of computer generation? How many
computer generations are defined? What technologies were / are
used?

Ans: Following is a brief summary of the genera of computers
based on their hardware and software archite

First Generation
In the late 1940s and early 1950s (

for storage.

Second Generation

In the late 1950s, transi

memories (IB 1, H . Size was reduced and reliability
was significagly improve

ThircdSentra
1d-1960s, utesilised the first integrated circuits (IBM 360,
0) and the fi rating systems and database management

st processing was still batch oriented using punch
cards and m I€t&pes, online systems were being developed. This
was the era of mainframes and minicomputers, essentially large
centralized computers and small departmental computers. See

Fourth Generation
the mid to late-1970s spawned the microprocessor and personal
computer, introducing distributed processing and office automation.




Word processing, query languages, report writers and spreadsheets put
large numbers of people in touch with the computer for the first time.

Fifth Generation - The Future

the 21st century ushered in the fifth generation, which increasingly
delivers various forms of artificial intelligence (Al). More sophisticated
search and natural language recognition are features that users
recognize, but software that improves its functio by learning on its
own will change just about everything in the tech@omrghin the future.

TECHNOLOGIES WERE/ARE USED

. Communications techfelog
. Office productivity. ...
Record keeping and retrievalt

Internet and s ™ 4

. Analytics ision structures. ...
uture factories. ...

augmented reality.




Q4.Differentiate between volatile & non- volatile
memories.

What is Volatile Memory?

Volatile Memory is the kind of computer memory th
temporarily. It is also referred as temporary mes
memory is stored only until the power is suj
system is turned off the data present inside
automatically. RAM and cache of th
example of the volatile memory. Vol
its stores only the frequently used datq.
the processor is stored in volatile memory.
nature and can be accessed rapidly. VVolatile m
performance of the corg . Tiie more
djter system will possess. Common
ude RAM, Cache, etc.

tRe non-volatile memory remains there even
M of the computer is the non-volatile
icient and fast in nature as compare to volatile
for the longer period. Non-volatile memory possesses
ation inside it such as the boot process information,
system starting u ormation and BIOS. Non-volatile memory is slow
regarding accessing. All such data that needs to be stored permanently or for
a longer period is stored in non-volatile memory. Non-volatile memory has a
direct impact on the system’s storage capability. The more non-volatile
memory, the more permanent storage space will be there. Common examples
of non-volatile memory include a hard drive, optical discs, flash memory, etc.




Volatile Memory vs. Non-Volatile Memory

. Volatile Memory is the temporary memory of the computer
system.

. Non-volatile Memory is the permanent memory of the computer
system.

. Data of programs in the process and frequently used data is stored
in volatile memory.

« System’s information, BIOS and all the ot
in non-volatile memory.

. Volatile memory is fast and efficie

. Non-volatile memory is slow and p

d of data is stored

Q5: Distinguish among system software [ ware and open
source software on the basis of their featur

sy‘m SO

Ans: Difference

software S(P SOTtwa

are and application

Sr. Key System Software. Application Software.

No.

tware is the type of On other hand Application

1 tween application software and which runs as per user request. It
tem. runs on the platform which is
provide by system software.
Development In general System software are While in case of Application
Language developed in low level language software high level language is
2 which is more compatible with the used for their development as the

oftware which is the interface Software is the type of software

system hardware in order to interact are developed as some specific
with. purpose software.




Sr.
No.

Some ex
software’s
( debugger

Key System Software. Application Software.
Usage System software is used for On other hand Application
operating computer hardware. software is used by user to

perform specific task.

On other hand Application
ftware are installed according t
S requirements.

the computer when operating

Installation System software are installed on
system is installed. '

interaction availa

User As mentioned in above p ‘ On othe application
interaction system software are spec are u n interacts with it
system hardware asuser i ace is available in th
ca
system software.

Dependency System software can run » On other hand in application
in ndently. It pr es platf software can’t run independently.
applic softwa They can’t run without the

presence of system software..

Exampl s of syStem On other hand some examples of
compiler, assembler, application software’s are word
r, etc. processor, web browser, media

player, etc.

v Open Sources

What is open source software?

Open source software is software with source code that anyone
can inspect, modify, and enhance.




"Source code" is the part of software that most computer users
don't ever see; it's the code computer programmers can
manipulate to change how a piece of software—a "program" or
"application"—works. Programmers who have access to a
computer program's source code can improve that program by
adding features to it or fixing parts that don't always work
correctly.

What's the difference between open sour
other types of software?

Some software has source cod
organization that created it—a

¥rs must agree (usually by
he first time they run this software)

Q6: (a) create a file in Ms Word to insert a paragraph
about yourself and save it with file name “yourself”.
Describe all steps involved in it.

Ans: we have some steps of ms word.




Firstly we go to the Ms Word.
Then we type our text in Ms Word.
After type the text we go to the office button.
Then click on save option.
After that we give file name
e Then we select save as

e Then click on ok.

Q6 (b): write step regardin%llo

% To changethe fo
% To chan@g the font
“ TaChange

light (im yellow) the line that reads “need to get

% ANS : to change the font style-

“* Firstly we select the given text.

% Then we go to the home tab.




% After that we go to the font group.

% Then we go to the font style and we will saw different
type of font style.

% After that we click on any one font style.

s To change the font size.

“* Firstly we select the given tex

% Then we go to the home

% After that we go to the font gr

+Then we select font colure as you want then click on
the colure.

“»To highlight (in yellow) the line that reads “need to
get IMS’s address”




firstly we select the given text ““ need to get IMS’s
address”

then click on home tab
Then we click on text highlight color on font group.
After that we choose yellow color.

. Create a file in Ms-Word fo ] cument
and save it with file name ‘Ms- '
involved in it.

Ms-Word is widely used commercial word processor

Ms-Word is application soft which is capﬂjif

e Creating

e Editing

e BRrinting any t

Ans: s

. Type the given text “Ms-word is widely used commercial word processor
developed by Microsoft.” Then press enter key

. Type “Ms-word is application software which is capable of” then press enter
key

. After that select “bullet” from “bulleted list” from “home tab”.




. Then type “creating” and press “enter key”. Then type
“Editing” and press “enter key”. After that type “saving and
press enter key”. Then we type “printing any type of
document” and press “enter key™.

.2

. Then we select word processor then we go to t me tab after that
we go to font group and we click on underli

. After that we select the creating tex@#é
on font color and select sky blue co

. Then we select saving text a
color and select red color.

the following document and
. Describe all steps involved

Equations

Xo+y

3 +Q4=50

8

= X
A:+B8 2+Y




Ans: we have some steps which we follow.

o Firstly we open the Ms-Word and write the
equations.

e Next we type X then we go to font group and
click on subscript then press 2 that we press

Then we press = butt
type 30

group. And press 4.
n = button then we type 50

. And type 2. After that we press +

keyboard. Then we type B and do
superscript from font group. Then we type 8.
After that we press = button. Then we type X
and again we do subscript. And press 2. Then we
press on + button. After that we type Y. then we
do superscript. And type 8.




o After that we go to the office button. And click
on save. After that we have give the file name
‘equations’ then click on save option.

Q9. Create a file in Ms-word that convert existing
highlight text to table as shown belqu and save it as

file name ‘text to table’ describe a s involved
It.

Select the text you want
Select the insert tab.
Click on table

Click on ¢
appears

Her

Clic OK fipally selected text convert in a table.

I Select the text you want to convert. Select the insert tab. [

Click on table command. A dialog box appears. Click on convert text to table, a new dialog box appears

Here set number of columns. Click on ok finally selected text convert in a table.




Ans. We have followed some steps.
o Firstly we select the text.
e Then go to insert tab.
e Then we go to the table option.
o After that we selected text tg

e Then we select on sepagate te
paragraph.

e After that we click on ok.

4

e Then fin

Ans: we follow some steps here.
e Firstly we go to the Ms-word.

e Then we go to the insert tab.




o After that we click on table.
e And go to insert table option.

e Then we select the rows number according you
wants. And then you select colugan numbers.
And click on ok.

o After that you will saw a

Q11. Create a following KS
save 1t with name ‘book’ ¥
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Ans: we have followed some steps.
o Firstly we go to Ms-excel. And open a sheet
e Then we type Roll no on a column.

o After that we type Roll no lane
downwards.

After that we type al
downward.

o After that otoc ?um type marks.

afks upward to downward.

tton and go to save
file name ‘book’1’and click

of data I orksheet created in question no 10.

e The sum of the marks using Auto sum in a
range of cells (c2:c11)

e Average of the marks in a range of cells (c2:c11)




e Highest marks in a range of cells (c2:c11)

e Minimum marks in a range of cells (c2:c11)

Ans: we have followed some steps here.

enter.

e For average firstly w

Then we type =AVE
enter.

e For highest N the insert function.
:.c11) and then press enter.

following.

e To modify column width of a worksheet.

e To modify the row height of a worksheet.




1

e To delete rows and columns of a worksheet.

Q13. (b) Describe following terms in the worksheet.

e Absolute reference and relative reference in
formula

e Cell address

Ans. (a) 1. Set a column tqga spet
. Select the column or columns that

2. On the Home tab, in the Cells group, C|ICk Format

3. Under Cell Size, click Column Width.

4. In the Column width box, type the value that you want.
5. Click OK.

. Tomo if)Qe row h‘ht of a worksheet.
|

. Click the Format command on the Home tab. The format drop-

down menu appears.

. Select the rows you want to modify.
. Select Row Height. Increasing the column width.
. The Row Height dialog box appears. Enter a specific

measurement. ...

. Click OK.




3. iIf you don't need any of the existing cells, rows or columns,
here's how to delete them:

1. Select the cells, rows, or columns that you want to delete.

2. 0n the Home tab, click the arrow under Delete, and then click
the appropriate delete option.

Ans.13 (b) Absolute reference and relati ference In

formula m

Relative references

By default, all cell references are relative references. When
copied across multiple cells, they change based on the relative
position of rows and columns. For example, if you copy the
formula =A1+B1 from row 1 to row 2, the formula will
become =A2+B2. Relative references are especially convenient
whenever you need to repeat the same calculation across
multiple rows or columns.

To create and copy a formula using relative references:

In the following example, we want to create a formula that will
multiply each item's price by the quantity. Rather than create a
new formula for each row, we can create a single formula in
cell D2 and then copy it to the other rows. We'll use relative
references so the formula correctly calculates the total for each
item.




e Cell address

The cell ADDRESS function is categorized under Excel Lookup
and Reference functions. It will provide a cell reference (its
“address”) by taking the row number and column letter. The cell
reference will be provided as a string of text. The function can
return an address in a relative or absolute format and can be used
to construct a cell reference inside a formula.

As a financial analyst, cell ADDRESS can be used to convert a
column number to a letter, or vice versa. We can use the
function to address the first cell or last cell in a range.

Formula

=ADDRESS (row_num, column_num, [abs_num], [al],
[sheet text])

The formula uses the following arguments:
|\ h 4 o _
1. Row_num (required argument) — This is a numeric value

specifying the row number to be used in the cell reference.
2. Column_num (required argument) — A numeric value
specifying the column number to be used in the cell
reference.
3. Abs_num (optional argument) — This is a numeric value
specifying the type of reference to return:




Q14. (a) What tools are available to customize our
PowerPoint presentation?

Ans (a) 1. Visme

Visme is a cloud-based presentation tool that allows you to
create highly visual presentations to engage viewers and
communicate your ideas. It features an intuitive, drag-and-drop
design method for creating presentations. The business version
also prioritizes brand consistency and company-wide image
storage. When you or your employees create a presentation, it
will feature colors, logos and images that are on brand for your
organization. This promotes consistency across presentations
among your employees. Visme also offers a built-in analytics
system, so you can see who has viewed your presentation and
who finished it.

Visme offers multiple plans ranging from $20 per user per
month to $60 per three users per month. It's also possible to get
a free live demo to see how the technology works before you try
it out.

2. Haiku Deck

Haiku Deck is a platform that prioritizes simplicity. Business
owners can create elegant, basic presentations with high-quality
Images. The Spartan approach allows for connecting with
audiences instead of losing them in information overload due to
text-heavy slides. What separates Haiku Deck from traditional
presentation tools is its library of images and array of fonts. It




makes it easy to craft simple, powerful presentations that are
accessible on any device.

Haiku Deck offers three plans, ranging from $7.99 to $29.99 per
month.

3. Pitcherific

Pitcherific is not only a presentation solution, but also a platform
for building and practicing your presentation. It's a template-
based program that guides you through the presentation creation
process. Instead of drafting a few slides, Pitcherific prompts you
to write out the areas of each part of your speech. The outline for
an elevator pitch, for example, includes a hook, problem,
solution and closing. There are various templates for different
kinds of pitches and presentations, so you'll have guidance on
many kinds of speeches and presentations. Pitcherific also
recommends a character count for each section and a timeclock,
allowing you to track how long your speech or presentation is
and stay within a desired range.

Pitcherific's pricing depends largely on your business and its
needs, so you'll have to reach out to its sales team to get a direct
quote. Pitcherific does offer a free trial in case you're curious to
see how the platform works.

4. Canva

Canva is an online platform that provides templates for a wide
range of business-related publications, like resumes, newsletters,
business cards, media Kits, brochures and info graphics. You can
also use it to construct presentations. There are hundreds of




design layouts and templates to start with, and you can upload
your own images or choose from more than 1 million of
Canvas’s stock images. As you build your presentation, you can
adjust text and fonts, add filters to images, and drag and drop
different elements for design. You can also upload and save
your company logo.

Canva offers a free version equipped with all its features. If
you're a startup or very small business owner, this is a good
option. For larger businesses, Canva for Work offers team
management features for $12.95 per month (or $9.95 per month
when you pay annually). You can try this version free for 30
days.

5. Slide Camp

Slide Camp provides slide templates for creating company
presentations. You can adjust color schemes, add company
logos, import charts and data, build info graphics, and organize
presentations into sections with Slide Camp. This is a great
solution for maintaining presentation consistency across
multiple presentations from your organization. After you set up
branding details, employees will be able to work with
predesigned slides to easily craft professional presentations. It's
geared for larger businesses, so if you're a startup or one-person
company, this may not be an ideal solution for you.

There are a few plans available, which range from $49 to $499
per month depending on the number of users who will access
Slide Camp. There is a demo version as well, so you can try out
the service to see if it's right for your business.




6. Microsoft Events

While PowerPoint may be a tired way to handle a business
presentation at times, Microsoft has other tools that can
introduce a new level of practicality to the standard presentation.
It recently introduced the ability to create live and on-demand
events in Microsoft 365. These events can be viewed in real time
or on demand by remote co-workers or even workers who were
present in the meeting but want to reference what was said. It
combines HD video with machine learning to create a speaker
timeline, speech-to-text transcriptions and time coding, and
closed captioning.

Live events are part of the Office 365 subscription plans. If
you're already a subscriber, you can use this tool for no
additional cost.

7. Powtoon

Powtoon is an animated presentation and video platform for
creating short informational videos and presentations about your
brand or product. Explainer videos are an important part of a
brand's message, and Powtoon is an affordable tool for creating
animated videos and presentations to educate consumers and
clients about your business. You can easily edit presentations
and videos, add voiceover, and build a professional experience
for your customers.

Powtoon offers a free version, but there are more robust
offerings at $19 and $59 per month.




8. Video Scribe

Video Scribe is a whiteboard video presentation platform that
allows small businesses to customize their presentations to fit
their needs. These videos, which feature a whiteboard and hand
that "draws" different objects and slides in the presentation, are
ideal for quick explainers and marketing videos on your
business or product. You can easily place objects, insert text,
and even draw your own objects or text with Video Scribe’s
platform.

Video Scribe is available for either $29 per user per month or, if
paid annually, $12 per user per month. If you want to extend
Video Scribe to a larger team, you'll have to pay $110 to $130
per user, depending on the number of users. You can also make
a one-time payment of $665 for a single user.

9. Prezi

Prezi is another template-based presentation solution that you
can use to create persuasive and engaging presentations with
unique movement between "slides" and key points. Prezi maps
out your whole presentation on an overall track that you decide.
When you switch slides, it doesn't simply advance to the next
one; it takes the viewer through the track to the point that needs
to be made. This allows your audience to visualize the
progression of your presentation. You can arrange content under
different sections and create an overview so your audience can
see your entire presentation plan. This method keeps the
presentation organized and your audience engaged. You can also
navigate freely through your presentation — your track is not




locked in and you can adjust when you address which points as
you're presenting.

Q14 (b) write the steps for the following action for creation of
power point presentation
e Open a blank presentation.
e Save the presentation as labl.pptx.
e Add atitle to the first slide the name of your collage.
Type your first name and last name in the subtitle section.
e Add a new slide which has a title and content.

AnNS. Opens a blank presentation.
» Select the File tab to go to backstage view.

» Select New on the left side of the window, and then
click Blank Presentation.

» A new presentation will appear.

SAVE THE PRESENTATION AS LAB 1. PPTX.

1. Locate and select the Save command on
the Quick Access Toolbar.

2. If you're saving the file for the first time, the Save As pane
will appear in backstage view.

3. You'll then need to choose where to save the file and give it
a file name. Click Browse to select a location on your
computer. Alternatively, you can click One Drive to save the
file to your One Drive.

4. The Save As dialog box will appear. Select the location where
you want to save the presentation.




5. Enter a file name for the presentation, then click Save.

6. The presentation will be saved. You can click
the Save command again to save your changes as you
modify the presentation.

You can also access the Save command by pressing Ctrl+S on
your keyboard.

Add a title to the first slide the name of your collage.

M N\
Select the slide whose layout you will change so that it can

have a title.
Click Home > Layout.

Select Title Slide for a standalone title page or
select Title and Content for a slide that contains a title and
a full slide text box. ...

Select the_CIick to add ﬂe text box.

Add a new slide which has a title and content.

. Select the slide whose layout you will change so that it can have
a title.

. Click Home > Layout.

. Select Title Slide for a standalone title page or select Title and
Content for a slide that contains a title and a full slide text box.

. Select the Click to add title text box.




Q15. Write steps for creation of a set of power point slides that
demonstrates your skills to use the tools of power point. It should
include the following things.

o Title slide & bullet list
e [Inserting excel sheet

e Clip art and text
([

Slide show effects
. Title slide & bullet list

. Select the slide whose layout you will chang‘e so that it can have
a title.

. Click Home > Layout.

. Select Title Slide for a standalone title page or select Title and
Content for a slide that contains a title and a full slide text box. .

. Select the Click to add title text box.
. o~ -wr
BULLET LIST
- "

. On the View tab, click Normal.

. Click in the text box or placeholder where you want to add
bulleted or numbered text.

. On the Home tab, in the Paragraph group, click Bullets or
Numbering. , and begin typing your list. Press Return
to create a new list item.

—

e Inserting excel sheet
e In PowerPoint, on the Insert tab, click or tap Object.

> In the Insert Object dialog box, select Create from file.
» Click or tap Browse, and in the Browse box, find the Excel
workbook with the data you want to insert and link to.




» Before you close the Insert Object box, select Link, and
click OK.

Clip art and text.

» Display a slide that contains a Clip Art icon on one of its
placeholders. ...

» Click the Clip Art icon to open the Clip Art task pane.

> In the Search For box, type a word that describes the artwork you
want; then click the Go button. ...

» Click the clip you want. ...

> (Optional) Move or resize the image as desired.

TEXT.
- . A 4
& Select a text placeholder or box.
& Type in the text you want.
&M N\ N

SLIDE SHOW EFFECTS:
- W A
1. Start by opening a "Blank presentation” in PowerPoint.

2.Select the "Title Slide" option. ...

3.Type in your title and subtitle. ...

4.Select a background for the entire presentation. ...
o.Add new slides. ...

6.Set the transitions for your slides. ...

/.Add some more pizzazz to
your presentation with animation!




Q16. What is the difference between machine language and
high level language?

Ans: High-Level Languages

A high-level language is a programming language that uses
English and mathematical symbols, like +, -, % and many
others, in its instructions. When using the term '‘programming
languages,' most people are actually referring to high-level
languages. High-level languages are the languages most often
used by programmers to write programs. Examples of high-level
languages are C++, FORTRAN, Java and Python.

To get a flavor of what a high-level language actually looks like,
consider an ATM machine where someone wants to make a
withdrawal of $100. This amount needs to be compared to the
account balance to make sure there are enough funds. The

instruction in a high-level computer language would look
something I|ke this:

x =100
if balance x
print “Insufficient balance!

else: \ v
print 'Please take ;our money"'

This is not exactly how real people communicate, but it is much
easier to follow than a series of 1s and Os in binary code.

There are a number of advantages to high-level languages. The
first advantage is that high-level languages are much closer to

the logic of a human language. A high-level language uses a set
of rules that dictate how words and symbols can be put together




to form a program. Learning a high-level language is not unlike
learning another human language - you need to learn vocabulary
and grammar so you can make sentences. To learn a
programming language, you need to learn commands, syntax
and logic, which correspond closely to vocabulary and grammar.

The second advantage is that the code of most high-level
languages is portable and the same code can run on different
hardware. Both machine code and assembly languages are
hardware specific and not portable. This means that the machine
code used to run a program on one specific computer needs to be
modified to run on another computer. Portable code in a high-
level language can run on multiple computer systems without
modification. However, modifications to code in high-level
languages may be necessary because of the operating system.
For example, programs written for Windows typically don't run
on a Mac.

A high-level language cannot be understood directly by a
computer, and it needs to be translated into machine code. There
are two ways to do this, and they are related to how the program
Is executed: a high-level language can be compiled or

interpreted.
h_\ N
MACHINE LANGUAGE:

Computherstand only the Ilanguage of Digital
Electronics. Digital Electronics deals with presence and absence
of voltages. Within the computer there are two logics can play
their role? These logics are —

. Positive Logic — Here presence of voltage will be denoted
by 1 and absence of voltage will be denoted by 0




Negative Logic —Here presence of voltage will be denoted
by 0 and absence of voltage will be denoted by 1

But obviously computer can follow anyone of the logics at a
time, not both the logics simultaneously. To make the computer
understand, a program can be written using only Os and 1s. The
data can also be specified and represented using only Os and 1s.
Such a program is called Machine Languag@program. Machine
language was the first in the evol of computer
programming languages. Computengmeli derstands a
program written in the machine

Disadvantages of machine languag

program in machinela ?
. ork with and highly error prone.

1 and 0 can get interchanged
. But then it is very difficult to
So a machine language program is

at the program, it is very difficult to
unction of the program. In fact, it is very

instruction in the program, or a data value, or the output
result. As instructions, data, output and operands, all are
represented using Os and 1s in machine language.

Machine language programs are platform and architecture-
dependent. The same program does not work on another
computer by a different manufacturer. This is because




machine language is different for different computers. Say
the bite pattern 11110000 means addition in one
architecture but might be representing subtraction in
architecture as well.

. To develop a program in machine language, the
programmer must be highly conversant with the
organization and architecture of the cofaputer system being
used.

Advantages of machine langua
advantages of writing in machine la

. The Machine language
program written in a

itself.

. A transl
so results in a che

Ans. Each variable in C has an associated data type. Each data type
requires different amounts of memory and has some specific
operations which can be performed over it. Let us briefly
describe therw by one:

Following are the examples of some very common data types
used in C:

. char: The most basic data type in C. It stores a single
character and requires a single byte of memory in almost all
compilers.




. Int: As the name suggests, an int variable is used to store an
integer.
. Float: It is used to store decimal numbers (numbers with
floating point value) with single precision.
. Double: It is used to store decimal numbers (numbers with
floating point value) with double precision.
Different data types also have different ranges up to which they
can store numbers. These ranges may vary from compiler to
compiler. Below is list of ranges along with the memory
requirement and format specifies on 32 bit gcc compiler.

short int -32,768 to 32,767

unsigned

short int 0 to 65,535

unsigned

Int 0 to 4,294,967,295

-2,147,483,648 to

2,147,483,647




long int

unsigned

long int

long long

int

unsigned
long long

int

signed char

unsigned

char

-2,147,483,648 t0 2,147,483,647

0t0 4,294,967,295

-(263) to (2°63)-1

Oto

18,446,744,073,709,551,615

-128 to 127

0to 255




float O%of

double %lf

long double ¢ %oLf

We can use the size of () operatoR to check the size of a variable. See
the following C program for the usage of the various data types:

N 2

Q18. Find the output of the following expressions.
a) X= 20/5*2+30-5 b) Y=30-(40/10+6)+10
c) Z= 40*2/10-2+10
Ans.a) X= 20/5*2+30-5=33 (b) Y=30-(40/10+6)+10=30
c) Z= 40*2/10-2+10=16

Q19. Describe the syntax of the following statements.

a) If —else statement (b). for loop (c) while loop
d) do- while loop

Ans. A) if — else statement- Syntax

The syntax of an if...else if...else statement in C programming
language is —



http://quiz.geeksforgeeks.org/sizeof-operator-c/

iIf (boolean_expression 1) {

[* executes when the Boolean expression 1 is true */
} else if (boolean_expression 2) {

/* executes when the Boolean expression 2 is true */
} else if (boolean expression 3) {

[* executes when the Boolean expression 3 is true */

}else {
[* executes when the none of the above CMS true */
} Al

b) For loop: The syntax of the for loop is:

for (initializationStatement; testExpression; updateStatement)

{

¥
C) While loop: The syntax of the while loop is:

/[ statements inside the body of loop

While (testExpression)
{

}

/[ statements inside the body of the loop

D) Do loop : // Program to add numbers until the user enters
Zero

#include <stdio.h>
int main()

{

double number, sum = 0;




/ the body of the loop is executed at least once
do

{

Printf("Enter a number: ");
scanf(%If", &number);
sum += number;

}

while (number !=0.0);
printf("Sum = %.21f",sum);

Return O;

Q20. Find the output of the followings program segments »
a)

#include<stdio.h>

Int main()

{
inti;
for(i=1; i<2; i++)
{
Printf(”’IMS Ghaziabad\n”’);

}
}
A20. a)Output-IMS Ghaziabad

b) #include<stdio.h>
int main()




Int i=1;
while (i<=2)
{
Printf(”’IMS Ghaziabad\n”);
i=i+1;
}

}
A20.b)Output=IMS Ghaziabad

IMS Ghaziabad

c)#include<stdio.h>

void main()

{
int a=10,b=100;
if(a>b)
printf(

()

Largest number is %d\n’’ ,a);
else

printf(“Largest number is %d\n” ‘b);

}
A20. C)Output=(“Largest nois b”)
















